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BOOSTXL-BASSENSORS User's Guide

The Building Automation Systems Sensors BoosterPack™ Plug-in Module kit (BOOSTXL-BASSENSORS)
is an easy-to-use module for adding digital sensors to your LaunchPad™ development kit design.
SimpleLink™ microcontroller (MCU) LaunchPad development kit developers can use this BoosterPack
plug-in module to start developing sensor applications using the onboard temperature, humidity, ambient
light, or magnetic flux sensor.

Figure 1. BOOSTXL-BASSENSORS BoosterPack™ Plug-in Module
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1 Getting Started

1.1 Introduction
The Building Automation Systems Sensors BoosterPack Plug-in Module kit (BOOSTXL-BASSENSORS) is
an easy-to-use module for adding digital sensors to the LaunchPad development kit design. For these
SimpleLink MCU LaunchPad development kits, engineers can use this BoosterPack plug-in module to
start developing sensor applications using the onboard temperature, humidity, ambient light, and magnetic
flux sensors.

1.2 Key Features
• High-Accuracy Temperature Sensor (TMP116)
• Combined Temperature and Humidity Sensor (HDC2010)
• Ambient Light Sensor (OPT3001)
• Hall Effect Sensor (DRV5055-Q1)
• Works With TI LaunchPad Development Kits

1.3 What's Included

1.3.1 Kit Contents
• 1x BOOSTXL-BASSENSORS BoosterPack plug-in module
• 1x quick start guide

1.4 Next Steps: Looking Into the Provided Code
The next steps after reviewing the EVM features are to open an integrated development environment
(IDE) and start looking at the code examples. Section 3 describes the example projects available for the
user to understand the provided software.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/tool/BOOSTXL-SENSORS
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2 Hardware
Figure 2 shows an overview of the BoosterPack plug-in module.

Figure 2. BOOSTXL-BASSENSORS Overview

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
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2.1 Hardware Features

2.1.1 BoosterPack™ Plug-in Module Pinout
Figure 3 shows the pinout of the BoosterPack plug-in module.

Figure 3. BoosterPack™ Plug-In Module Pinout

The Building Automation Systems Sensors BoosterPack plug-in module adheres to the 40-pin LaunchPad
development kit and BoosterPack plug-in module pinout standard. A standard was created to aid
compatibility between LaunchPad development kits and BoosterPack plug-in modules across the TI
ecosystem.

The 40-pin standard on the BOOSTXL-BASSENSORS is compatible with the 20-pin standard that is used
by other LaunchPad development kits like the MSP-EXP430G2 LaunchPad development kit. This allows
for 40-pin BoosterPack plug-in modules to be used with 20-pin LaunchPad development kits.

The BOOSTXL-BASSENSORS BoosterPack plug-in module has both male and female headers to support
stacking on top. The user must carefully consider stacking other BoosterPack plug-in modules near the
BASSensors BoosterPack plug-in module as heat, shade, and electromagnetic fields can adversely affect
the sensors readings.

For more information on EVM compatibility with TI LaunchPad development kits, refer to
www.ti.com/launchpad.

2.1.2 I2C Addresses

Device 7 bit Address Hex
OPT3001 1000100 44
TMP116 1001000 48

HDC2010 1000000 40

2.1.3 TI OPT3001 Light Sensor
The OPT3001 is a digital ambient light sensor (ALS) that measures the intensity of light as visible by the
human eye. Covering the sensor with a finger or shining a flashlight on it changes the output of the
OPT3001. The digital output is reported over an I2C- and System Management Bus (SMBus)-compatible,
2-wire serial interface. The reference designator for the OPT3001 is U1. Table 1 lists the pin connections
of the OPT3001.

For more information on the OPT3001 light sensor, refer to the OPT3001 product folder.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/tool/BOOSTXL-SENSORS
http://www.ti.com/tool/msp-exp430g2
http://www.ti.com/tool/BOOSTXL-SENSORS
http://www.ti.com/launchpad
http://www.ti.com/product/opt3001
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(1) I2C Pins are shared amongst the TMP116, HDC2010, and OPT3001.

Table 1. OPT3001 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J1.27 OPT3001 V+ Supply Pin

2.1.4 TI TMP116 Temperature Sensor
The TMP116 is a 16-bit digital local temperature sensor that measures the ambient temperature or the
temperature of an object in direct contact. Despite being a contact sensor, thesensitivity and accuracy of
the TMP116 is high enough to detect a change in temperature from a hand placed near the sensor. The
digital output is reported over an I2C- and SMBus-compatible, 2-wire serial interface. The reference
designator for the TMP116 is U1. Table 2 lists the pin connections of the TMP116.

In order to use the TMP116, the included ribbon cable must be connected. The metal contacts of the
cable must face down in the connector to make electrical contact. The black tab on the cable should be
face up.

For more information on the TMP116 temperature sensor, refer to the TMP116 product folder.

(1) I2C Pins are shared amongst TMP116, HDC2010, and OPT3001.

Table 2. TMP116 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J1.28 TMP116 V+ Supply Pin

2.1.5 TI HDC2010 Humidity Sensor
The TI HDC2010 is an integrated temperature and humidity sensor that measures ambient temperature
and relative humidity in RH%. The sensor can detect an increase in moisture and temperature in a
person's breath. The digital output is reported over an I2C- and SMBus-compatible 2-wire serial interface.
The reference designator for the HDC2010 is U3. Table 3 lists the pin connections of the HDC2010.

For more information on the HDC2010 humidity sensor, refer to the HDC2010 product folder.

(1) I2C Pins are shared amongst TMP116, HDC2010, and OPT3001.

Table 3. HDC2010 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J1.23 Enable HDC2010 3.3V Supply

2.1.6 TI DRV5055-Q1 Hall Effect Sensor
The TI DRV5055-Q1 Hall EffectSensor measures the strength of magnetic fields in one axis. Placing a
magnet near the sensor increases the sensor output. The output of the sensor is an analog voltage which
must be sampled by an ADC and converted to milliTesla. The reference designator for the DRV5055-Q1 is
U4. Table 4 lists the pin connections of the DRV5055-Q1.

For more information on the DRV5055-Q1 hall effect sensor, refer to the DRV5055-Q1 product folder.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/product/tmp116
http://www.ti.com/product/hdc2010
http://www.ti.com/product/drv5055-q1
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Table 4. DRV5055-Q1 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.2 DRV5055-Q1 Analog Output
J1.24 Enable DRV5055-Q1 3.3-V Supply

2.2 Power
The board was designed to be powered by the attached LaunchPad development kit.

2.2.1 LaunchPad™ Development Kit Default Power
Power is provided through the 3V3 (J1.1) pin on the BoosterPack plug-in module headers. The 3V3 pin
powers everything on the BASSensors BoosterPack plug-in module.

2.3 Design Files

2.3.1 Hardware
Schematics can be found in Section 5. All design files including schematics, layout, bill of materials
(BOM), Gerber files, and documentation are available on the BOOSTXL-BASSENSORS Hardware Design
Files on the download page.

2.3.2 Software
All design files including software example projects, and documentation are available in the software
folders that are specific to each LaunchPad development kit. To see which LaunchPad development kits
feature BOOSTXL-BASSENSORS examples, visit the download page.

2.4 Hardware Change Log
Table 5 lists the hardware revision history.

Table 5. Hardware Change Log

PCB Revision Description
Rev 1.0 Initial release

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/tool/boostxl-bassensors
http://www.ti.com/tool/boostxl-bassensors
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3 Software Examples
The following software examples are included with the Sensor and Actuator Plugin for SimpleLink MCU
SDKs (see Table 6). These examples can be found in the SIMPLELINK-SDK-SENSOR-ACTUATOR-
PLUGIN , which is commonly installed as C:\ti\sail. Note that the SimpleLink SDK for your MCU must be
installed alongside the SAIL plugin. Within the sail folder, the software examples are located in
examples/rtos/[LaunchPad]/sail/. The software examples are compatible with the following LaunchPads:
• CC1310_LAUNCHXL
• CC2640R2_LAUNCHXL
• CC3220S_LAUNCHXL
• CC3220SF_LAUNCHXL
• MSP_EXP432E401Y
• MSP_EXP432P401R

Table 6. Software Examples

Demo Name
LaunchPad™ /
BoosterPack™

Required
Description More Details

adcdrv5055
SimpleLink MCU /

BOOSTXL-
BASSENSORS

Samples voltage from DRV5055-Q1 using MCU
Onboard ADC, convert voltage to milliTesla and
report using UART.

Section 3.1

i2chdc2010
SimpleLink MCU /

BOOSTXL-
BASSENSORS

Sample data from HDC2010 using I2C, convert
to temperature/humidity and report using UART. Section 3.2

i2copt3001
SimpleLink MCU /

BOOSTXL-
BASSENSORS

Sample data from OPT3001 using I2C, convert
to lux and report using UART. Section 3.3

i2ctmp116
SimpleLink MCU /

BOOSTXL-
BASSENSORS

Sample data from TMP116 using I2C, convert to
temperature and report using UART. Section 3.4

To use one of the software examples with the LaunchPad development kit, the user must have an
integrated development environment (IDE) that supports the SimpleLink MCU devices (see Table 7).

Table 7. IDE Minimum Requirements

Code Composer Studio™ IDE IAR Embedded Workbench® for ARM® IDE ARM® Keil® µVision® IDE
v7.1.0 v7.80.3 MDK-ARM v5

For more details on how to get started quickly, and where to download the latest CCS, IAR, and Keil IDEs,
see Section 4.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
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3.1 DRV5055-Q1 Software Example
This section describes the functionality and structure of the adcdrv5055 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/adcdrv5055

3.1.1 Source File Structure
The project is split into multiple files (see Table 9). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 8. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software

tirtos/gcc CCS project files used for importing this Software Example into Code Composer Studio software
using the gcc compiler

tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench

adcdrv5055.c Contains MainThread for RTOS application and function which queries ADC connected to
DRV5055-Q1

Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
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3.2 HDC2010 Software Example
This section describes the functionality and structure of the i2chdc2010 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2chdc2010

3.2.1 Source File Structure
The project is split into multiple files (see Table 9). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 9. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software

tirtos/gcc CCS project files used for importing this Software Example into Code Composer Studio software
using the gcc compiler

tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i2chdc2010.c Contains MainThread for RTOS application and function which queries HDC2010 using I2C
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
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3.3 OPT3001 Software Example
This section describes the functionality and structure of the i2copt3001 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2copt3001

3.3.1 Source File Structure
The project is split into multiple files (see Table 9). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 10. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software

tirtos/gcc CCS project files used for importing this Software Example into Code Composer Studio software
using the gcc compiler

tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i2copt3001.c Contains MainThread for RTOS application and function which queries OPT3001 using I2C
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
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3.4 TMP116 Software Example
This section describes the functionality and structure of the i2ctmp116 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2ctmp116

3.4.1 Source File Structure
The project is split into multiple files (see Table 9). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 11. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software

tirtos/gcc CCS project files used for importing this Software Example into Code Composer Studio software
using the gcc compiler

tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i2ctmp116.c Contains MainThread for RTOS application and function which queries TMP116 using I2C
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
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4 Additional Resources

4.1 TI LaunchPad™ Development Kit Portal
More information about LaunchPad development kits, supported BoosterPack plug-in modules, and
available resources can be found at:
• TI's LaunchPad portal: Information about all LaunchPad development kits from TI, for all

microcontrollers

4.2 TI Cloud Development Tools
TI's Cloud-based software development tools provide instant access to SimpleLink SDK content and a
web-based IDE.

4.2.1 TI Resource Explorer Cloud
TI Resource Explorer Cloud provides a web interface for browsing examples, libraries, and documentation
found in the SimpleLink SDK without having to download files to the local drive (see Figure 4).

Learn more about TI Resource Explorer Cloud at https://dev.ti.com/.

Figure 4. TI Resource Explorer Cloud

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/launchpad
https://dev.ti.com/
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4.2.2 Code Composer Studio™ Cloud IDE
Code Composer Studio Cloud (CCS Cloud) IDE is a web-based IDE that lets you quickly create, edit,
build, and debug applications for the LaunchPad development kit (see Figure 5). There is no need to
download and install large software packages. The user can simply connect the LaunchPad development
kit and begin. The user can choose to select from a large variety of examples in the SimpleLink MSP432
SDK and Energia or develop their own application. CCS Cloud IDE supports debug features such as
execution control, breakpoints, and viewing variables.

A full comparison between CCS IDE Cloud and CCS Desktop is available here.

Learn more about Code Composer Studio Cloud IDE at https://dev.ti.com/.

Figure 5. CCS Cloud

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
https://dev.ti.com/about#cloudordesktop
https://dev.ti.com/
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4.3 Code Composer Studio™ IDE
Code Composer Studio IDE Desktop is a professional integrated development environment that supports
TI's microcontroller and Embedded Processors portfolio. Code Composer Studio IDE comprises a suite of
tools used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source
code editor, project build environment, debugger, profiler, and many other features.

Learn more about CCS IDE and download it at www.ti.com/tool/ccstudio.

CCS IDE v6.1 or higher is required. When CCS has been launched, and a workspace directory chosen,
use Project>Import Existing CCS Eclipse Project. Direct it to the project directory that contains the main.c
of the desired demo (see Figure 6).

Figure 6. Directing the Project>Import Function to the Demo Project

The user can also select the \CCS subdirectory. The CCS-specific files are located there.

When the user clicks OK, the CCS should recognize the project and allow import.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://www.ti.com/tool/ccstudio
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The project appears in the Import CCS Eclipse Projects window and has a checkmark to the left of it if the
CCS found the project (see Figure 7).

Figure 7. When CCS Has Found the Project

Sometimes the CCS IDE finds the project but does not show a checkmark. This may mean that the
workspace already has a project by that name. The user can either rename or delete that project to fix this
issue. If the project does not appear in the CCS IDE workspace, make sure to check the workspace
directory on the file system.

4.4 IAR Embedded Workbench® for TI MSP430™ MCUs
IAR Embedded Workbench for MSP430™ MCUs is another very powerful integrated development
environment that allows you to develop and manage complete embedded application projects. IAR
Embedded Workbench integrates the IAR C/C++ Compiler, IAR Assembler, IAR ILINK Linker, editor,
project manager, command line build utility, and IAR C-SPY® Debugger.

Learn more about the IAR Embedded Workbench for MSP430 MCUs and download the software at
www.iar.com/.

IAR 6.10 or higher is required. To open the demo in IAR, click File>Open>Workspace…, and browse to
the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project>Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and
install MSP430Ware™ software that contains MSP430 MCU libraries and the TI Resource Explorer.
These are already included in a Code Composer Studio IDE installation unless the user selected
otherwise.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
https://www.iar.com/
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4.5 Energia
Energia is a simple, open-source, and community-driven code editor that is based on the Wiring and
Arduino framework. Energia provides unmatched ease of use through very high-level APIs that can be
used across hardware platforms. Energia is a lightweight IDE that does not have the full feature set of
Code Composer Studio IDE or IAR Embedded Workbench IDE. However, Energia is great for anyone who
wants to get started very quickly or who does not have significant coding experience.

Learn more about Energia and download it at www.energia.nu.

4.6 SimpleLink™ MSP432 SDK, MSP430Ware™ Software, and TI Resource Explorer
The MSP432 device is part of the SimpleLink microcontroller (MCU) platform, which consists of Wi-Fi®,
Bluetooth® low energy, Sub-1 GHz, and host MCUs. All share a common, easy-to-use development
environment with a single core software development kit (SDK) and rich tool set. A one-time integration of
the SimpleLink platform lets you add any combination of devices from the portfolio into your design. The
ultimate goal of the SimpleLink platform is to achieve 100 percent code reuse when your design
requirements change. For more information, visit www.ti.com/simplelink.

For the 16-bit MSP430 MCUs, the MSP430Ware software package is used. MSP430Ware software is a
complete collection of libraries and tools. It includes a driver library (driverlib) graphics library (grlib), and
many other software tools. MSP430Ware software is optionally included in a Code Composer Studio IDE
installation or can be downloaded separately. IAR users must download it separately.

Both the SimpleLink MSP432 SDK and the MSP430Ware software are included in the TI Resource
Explorer for easily browsing tools, documents, examples, and more (see Figure 8).

Figure 8. TI Drivers Software Examples in TI Resource Explorer

Inside TI Resource Explorer, these examples and many more can be found and easily imported into Code
Composer Studio IDE with one click.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://wiring.org.co/
http://arduino.cc/
http://www.energia.nu/
http://www.ti.com/simplelink
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4.7 The Community

4.7.1 TI E2E™ Online Community
Search the forums at e2e.ti.com for helping building your EVM boards. If you cannot find the answer, post
a question to the community.

4.7.2 Community at Large
Many online communities focus on the LaunchPad development kit and BoosterPack plug-in module
ecosystem likewww.43oh.com. You can find additional tools, resources, and support from these
communities.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://e2e.ti.com/
http://www.43oh.com/
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5 Schematics
Figure 9 shows the schematic. Hardware design files can be found in the BOOSTXL-BASSENSORS Hardware Design Files.

Figure 9. Schematics

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU762
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/BOOSTXL-SENSORS/latest/index_FDS.html
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IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated (‘TI”) technical, application or other design advice, services or information, including, but not limited to,
reference designs and materials relating to evaluation modules, (collectively, “TI Resources”) are intended to assist designers who are
developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you
(individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of
this Notice.
TI’s provision of TI Resources does not expand or otherwise alter TI’s applicable published warranties or warranty disclaimers for TI
products, and no additional obligations or liabilities arise from TI providing such TI Resources. TI reserves the right to make corrections,
enhancements, improvements and other changes to its TI Resources.
You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your
applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications
(and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You
represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1)
anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that
might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you
will thoroughly test such applications and the functionality of such TI products as used in such applications. TI has not conducted any
testing other than that specifically described in the published documentation for a particular TI Resource.
You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include
the TI product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO
ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY
RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or
other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or
endorsement thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the
third party, or a license from TI under the patents or other intellectual property of TI.
TI RESOURCES ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR
REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO
ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL
PROPERTY RIGHTS.
TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT
LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF
DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL,
COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR
ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.
You agree to fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-
compliance with the terms and provisions of this Notice.
This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, TI products and services.
These include; without limitation, TI’s standard terms for semiconductor products http://www.ti.com/sc/docs/stdterms.htm), evaluation
modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).
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STANDARD TERMS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or

documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License

Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.



FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page


【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page


6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated



IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated (‘TI”) technical, application or other design advice, services or information, including, but not limited to,
reference designs and materials relating to evaluation modules, (collectively, “TI Resources”) are intended to assist designers who are
developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you
(individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of
this Notice.
TI’s provision of TI Resources does not expand or otherwise alter TI’s applicable published warranties or warranty disclaimers for TI
products, and no additional obligations or liabilities arise from TI providing such TI Resources. TI reserves the right to make corrections,
enhancements, improvements and other changes to its TI Resources.
You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your
applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications
(and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You
represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1)
anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that
might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you
will thoroughly test such applications and the functionality of such TI products as used in such applications. TI has not conducted any
testing other than that specifically described in the published documentation for a particular TI Resource.
You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include
the TI product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO
ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY
RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or
other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or
endorsement thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the
third party, or a license from TI under the patents or other intellectual property of TI.
TI RESOURCES ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR
REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO
ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL
PROPERTY RIGHTS.
TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT
LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF
DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL,
COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR
ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.
You agree to fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-
compliance with the terms and provisions of this Notice.
This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, TI products and services.
These include; without limitation, TI’s standard terms for semiconductor products http://www.ti.com/sc/docs/stdterms.htm), evaluation
modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated
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